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1 Tekla Structural Designer 2021
release notes

Welcome to Tekla Structural Designer 2021!

Select your headcode/region from the list below to see the many new features
and improvements that apply to you in this version:

1.1 US
General & Modeling

• New Embodied Carbon Calculation & Design Efficiency Assessment
(page 9)

• New Fireproofing (page 25)

• New Automatic Backups (page 29)

Loading

• New Open Structure Wind Load (page 32)

• New Equipment Load Entities (page 37)

Analysis & Results

• New Partially Cracked Concrete Walls & Members (page 43)

Design

• Issues with associated bulletins (page 9)

• New Steel Column Base Plate Connection Modeling & Design - Eurocode
and USA Head Codes (page 47)

• Enhanced Sway/ Drift/ Wind Drift & Seismic Drift Check Control and
Reporting - All Head Codes (page 60)

• New Reinforced Concrete Design to ACI 318-2019 - US Head Code
(page 72)
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• Foundation Design - New Lateral Load Check for Pile Caps and Piled Mats
(page 76)

Other Enhancements & Fixes

• Other Enhancements and Fixes (page 79)

NOTE The number in brackets before an item denotes an internal reference
number. This can be quoted to your local Support Department should further
information on an item be required.

1.2 Eurocode
General & Modeling

• New Embodied Carbon Calculation & Design Efficiency Assessment
(page 9)

• New Fireproofing (page 25)

• New Automatic Backups (page 29)

Loading

• New Open Structure Wind Load (page 32)

• New Equipment Load Entities (page 37)

Analysis & Results

• New Partially Cracked Concrete Walls & Members (page 43)

Design

• New Steel Column Base Plate Connection Modeling & Design - Eurocode
and USA Head Codes (page 47)

• Enhanced Sway/ Drift/ Wind Drift & Seismic Drift Check Control and
Reporting - All Head Codes (page 60)

• Foundation Design - New Lateral Load Check for Pile Caps and Piled Mats
(page 76)

• Design Using Tekla Portal Frame Designer - Improvements for Class 4
Haunches - Eurocode (page 79)

Other Enhancements & Fixes

• Other Enhancements and Fixes (page 79)

NOTE The number in brackets before an item denotes an internal reference
number. This can be quoted to your local Support Department should further
information on an item be required.
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1.3 BS
General & Modeling

• New Embodied Carbon Calculation & Design Efficiency Assessment
(page 9)

• New Fireproofing (page 25)

• New Automatic Backups (page 29)

Loading

• New Equipment Load Entities (page 37)

Analysis & Results

• New Partially Cracked Concrete Walls & Members (page 43)

Design

• Enhanced Sway/ Drift/ Wind Drift & Seismic Drift Check Control and
Reporting - All Head Codes (page 60)

• Foundation Design - New Lateral Load Check for Pile Caps and Piled Mats
(page 76)

Other Enhancements & Fixes

• Other Enhancements and Fixes (page 79)

NOTE The number in brackets before an item denotes an internal reference
number. This can be quoted to your local Support Department should further
information on an item be required.

1.4 India
General & Modeling

• New Embodied Carbon Calculation & Design Efficiency Assessment
(page 9)

• New Fireproofing (page 25)

• New Automatic Backups (page 29)

Loading

• New Open Structure Wind Load (page 32)

• New Equipment Load Entities (page 37)

Analysis & Results

• New Partially Cracked Concrete Walls & Members (page 43)

Design
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• Enhanced Sway/ Drift/ Wind Drift & Seismic Drift Check Control and
Reporting - All Head Codes (page 60)

• Foundation Design - New Lateral Load Check for Pile Caps and Piled Mats
(page 76)

Other Enhancements & Fixes

• Other Enhancements and Fixes (page 79)

NOTE The number in brackets before an item denotes an internal reference
number. This can be quoted to your local Support Department should further
information on an item be required.

1.5 Australia
General & Modeling

• New Embodied Carbon Calculation & Design Efficiency Assessment
(page 9)

• New Fireproofing (page 25)

• New Automatic Backups (page 29)

Loading

• New Equipment Load Entities (page 37)

Analysis & Results

• New Partially Cracked Concrete Walls & Members (page 43)

Design

• Enhanced Sway/ Drift/ Wind Drift & Seismic Drift Check Control and
Reporting - All Head Codes (page 60)

Other Enhancements & Fixes

• Other Enhancements and Fixes (page 79)

NOTE The number in brackets before an item denotes an internal reference
number. This can be quoted to your local Support Department should further
information on an item be required.
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1.6 Compatibility
We suggest that you complete any unfinished models using your current
version of Tekla Structural Designer.

This version is not backwards compatible. When you create or save a model in
Tekla Structural Designer 2021, you cannot open it in older versions due to
database differences.

We suggest that Tekla Structural Designer 2021 is only installed on systems
meeting these hardware recommendations.

If you are upgrading from a version earlier than the latest release 2020 SP6
(version 20.0.6.29 released Jan 2021) you can find details of requirements,
enhancements and fixes for all previous releases in Tekla User Assistance
(TUA) and Tekla Downloads via the links below:

• Tekla User Assistance Main version release notes

• Tekla User Assistance Service Pack release notes

• Tekla Downloads

1.7 Issues with associated bulletins
• [TSD-8930] - Composite Beam Design - US Head Code - this issue relates to

the design of composite beams for the United States (AISC/ACI) Head code
and the AISC 360/341 resistance code. In some circumstances an incorrect
overall pass design status could be reported when the Connector
Resistance check governed design and reported a warning or fail status. It
is believed that the latter would be a relatively rare occurrence since, for
this to happen, the issue described in bulletin PBTSD-2102-02 must also
occur. For more information please see Product Bulletin PBTSD-2102-01.

• This issue is fixed in this release.

• [TSD-8759] - Composite Beam Design - US Head Code - this issue relates to
the design of composite beams for the United States (AISC/ACI) Head code
and the AISC 360/341 resistance code. In some circumstances an incorrect
pass status could be reported for the Flexure check when the Connector
Resistance check failed. When the related issue detailed in bulletin
PBTSD-2102-01 also occurred, an incorrect overall passing status could
potentially be incorrectly displayed. However, it is believed that this would
be a relatively rare occurrence. For more information please see Product
Bulletin PBTSD-2102-02.

• This issue is fixed in this release.
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1.8 New Embodied Carbon Calculation & Design
Efficiency Assessment
With an exciting further development of recent features to assess the Carbon
Impact of design, this release adds an automated and comprehensive new
built-in calculation of Embodied Carbon quantities, together with powerful new
options for graphical review/ optimization and reporting of this aspect of
design. For information about recently added related features see the 2020
SP6 release note sections Review View - Design Status Enhancements and
Material List Enhancements (material quantity improvements detailed in this
are directly used in the new Embodied Carbon calculation) and the help topic
on the Export to One Click LCA feature (released in 2020 SP5).

For more background on Embodied Carbon calculation see this Institute of
Structural Engineering guide “How to calculate embodied carbon”. With
reference to this, the new calculation in Structural Designer essentially deals
with stages A1 to A3 for the construction products in a project (commonly
termed the ‘Product stage” or “cradle to gate” stage), over which the design
engineer has direct influence and which typically account for some 50% of all
Embodied Carbon in a building project life cycle. The picture directly below
shows an example of the new graphical review capability for Embodied
Carbon together with just a small sample of the reporting options; the
Overview report giving totals for the entire model (both by entity and
grouped by plane) and just part of a Detail report for steel composite beams.

Here, and also in this related video, we will highlight some key aspects of the
settings and workflow for this feature.
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• Embodied Carbon Factors (ECF) - at the heart of this new feature is the
Embodied Carbon Factors (ECF) definitions dialog shown below, which lists
the factors and controls how they are assigned to the entities in the model.
The ECF value is the key value required for the calculation, being the mass
of embodied carbon per unit mass or area of a material or surface e.g.
kgCO2e/kg. The ECF dialog is accessed from the new “Embodied Carbon
Factors” button on the Home tab of the Ribbon. Assignment of ECFs to the
model entities and the resulting Embodied Carbon calculation is entirely
automatic and updates in real-time following edits to the list/ factors.
Automated ECF assignment is controlled first by the order of the factor list
then by the criteria set for each individual factor.
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• This feature is applicable to all Head Codes & Countries. Some sample ECF
definitions have been added to the Settings sets for all countries/ codes for
the following categories in general; Concrete, Metal Deck, Reinforcement,
Steel, Timber. Note the following:

• We would note that there is potentially considerable variability/
uncertainty in ECFs - for example for Concrete, many mix variations are
possible for every strength grade and all could be unique. Hence the
sample ECF’s are included principally for guidance and are not a
complete set - the engineer is advised to review, edit and add to them
as they need. To establish ECF values you can for example consult an
Environmental Product Declaration (EPD) where available from
construction product suppliers/ manufacturers.

• Existing Installations - for an existing installation, your current settings
sets (from the latest currently installed version) will be copied to this
release. Hence, to use the sample ECFs, it is necessary to first import
the new 2021 Settings sets for your preferred country/ countries into
global settings. New models created with these new settings set(s)
active will then contain the new ECF definitions. For existing models the
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ECFs can be loaded via Home > Embodied Carbon Factors > Load…
(from the currently active global settings).

• If you wish to add the ECF definitions to your own settings set(s), you
can do this as follows:

• Step 1 - import a new 2021 settings set, set it to be Active, OK this
then create a new model - this will contain the sample ECF
definitions.

• Step 2 - open Home > Settings and set your settings set to be
Active.

• Step 3 - open the ECF dialog and click the [Save…] button, you can
then confirm the load the ECF definitions into your settings set
from the model as shown in the picture below.

• Steel Connections Allowance - note that there is also a new model setting
for the Embodied Carbon calculation to make an allowance for the
additional amount within steel connections. This is found in both Global
and Model Settings > Embodied Carbon > Steel connections. There are
separate settings for the allowances for Pin-ended (default 5%) and Fixed-
ended connections (default 10%).

• ECF Definition & Assignment - key aspects of the ECF definition and
assignment process are:

• Open the ECF dialogue to review the current assignment of ECFs which
is constantly active, starting at the top of the list of ECFs and working
down, so the top factor has first priority and so on. The list order can be
changed simply by dragging and dropping factors with the mouse. The
assignment of factors updates automatically as edits are made to the
list order, and the number of entities to which an ECF is assigned to is
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given at the right of each factor entry - e.g. 60 for the top “UK rolled
hollow sections…” ECF shown in the picture below.

• Once an entity in the model has a factor from the list assigned the
process stops for that entity and category, hence there is no
duplication of factor assignment within a category where lower (in
the list) ECF definitions are also applicable.

• It is important to note here that there is not a one-to-one
relationship between model entities and ECFs - for example a
reinforced concrete member will have different ECFs assigned for
both its concrete material and its rebar.

• Factors can also be activated/ inactivated via the checkbox at the left
of each factor entry.

• To use the ECF dialog you first select the main Category you wish to
view/ edit at the top left e.g. “Steel” in the picture above. You can then
review for this category the ECF list order, description (which can be any
variation of text and numbers etc)value, and the number of assigned
entities where applicable.

• The list of factors in the main dialog can be further controlled by
additional filters below the main Category, those available being
dependent on the selected category - e.g. by a Grade filter for the
material categories and/ or by a Country filter for categories such as
Reinforcement and Metal deck.

• Next, via the Add/ Edit factor options, you can review/ edit the
description and/ or value for ECFs and add additional ones. You can
also set the Category and Entity filters which control the grades and/
or entity types to which the factor applies. For example you could

Tekla Structural Designer 2021 release notes 14 New Embodied Carbon Calculation & Design
Efficiency Assessment



set a factor for the Concrete category that applies only to the specific
grade C32/40 and only concrete columns and beams.

• The category and entity filters available in the Edit Factors dialog
are dictated by the main Category filter set at the top left of the
dialog - e.g. “Concrete”, “Steel”, “Cladding” etc. Thus for example
only steel entity types are listed in the Edit Factor dialog’s Entity
filter list when “Steel” is set as the main dialog Category.

• Review, Adjustment & Reporting - while the key result of focus is the
total Embodied Carbon quantity for the whole model (as shown in the
Embodied Carbon Overview Table in the picture above), the engineer will
also likely wish to drill down to see how this is calculated and identify
areas/objects with high carbon impact that can potentially be improved. A
good deal of the development focus for the new features has gone into this
aspect. The engineer can review the Embodied Carbon results as follows:

• Graphical Review/ Adjustment - Review View > Show/Alter state now
has powerful new commands to rapidly review and edit the embodied
carbon result and settings; “Carbon Factors” and “Utilization and
embodied carbon”. These are activated via the new “Embodied Carbon”
button in the Show/Alter state group of the Review ribbon and then
controlled by their Properties Window settings.

• Carbon factors - the new Carbon Factors attribute has both Review
and Override modes. In the Review mode you can see the
distribution of carbon factors throughout the model via a colour
coded view. The view legend lists the factor values with the number
of entities for each being shown adjacent to the factor value in
brackets, as shown in the picture below. Here you can see that
different factors are assigned based on the steel section shape; the
hollow sections having a slightly higher ECF of 2.5 than the open
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sections (see picture of ECF’s above). The cursor tooltip also lists the
ECF value for a selected member.

• Note also the Carbon Source category and Entity type filters
which allow you to restrict the view to specific categories/ entity
types e.g. Steel Members as shown in the view below.

• You can also use the “Set override” mode to directly apply carbon
factors as shown in the picture below - the legend and color
coding adjust appropriately to the current override value to show
entities with values above/ below it, with the override value set
and with other override values > and < this. Overrides can also be
removed with the “Remove override” mode.

• Note that we recommend Set override is used to make limited
changes to ECFs rather than for the majority of the model -
managing and application of ECFs is most effectively done via
ECF definitions which are automatically assigned for you as
discussed above. Setting overrides is primarily recommended
for entities that require different factors but are
indistinguishable in terms of their data (and so cannot be
assigned automatically) such as Roof/ Wind panels (in the
“Cladding” category).
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• Overrides also appear in the ECF dialogue as ‘Custom’ values
where they can be edited or deleted. Deletion removes the
override for all entities linked to the factor.

• Utilization and embodied carbon - this mode enables you to see
the distribution of the amount of embodied carbon for each entity.
Again you can use the category and entity type filters to tailor the
view to what you want to focus on - e.g. Reinforcement in members
as shown below.
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• It is important to note here again, as we did earlier, that there is
not a one-to-one relationship between entities and ECFs - for
example a reinforced concrete member will have different ECFs
assigned for both its concrete material and its rebar, both of
which will contribute to the member’s total embodied carbon
quantity. Hence the facility to restrict the view to specific
categories.
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• The Utilization and embodied carbon attribute also features
additional filters for Utilization ratio (UR) and Embodied carbon,
both of which allow you to set thresholds for the visible entities;
either above/ below an absolute value or a highest or lowest %
proportion. You can use these filters singly, or simultaneously for
example to focus on entities with both a low UR and high
embodied carbon by setting the UR filter to “Value below” with a
value limit = 0.5 and the Embodied carbon filter to “Highest X%”
and Highest = 50%, as shown in the picture below.
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• Tabular Review & Reporting - a comprehensive set of tables for the
Embodied Carbon results is added in Review View > Tabular Data. These
give both a brief overview and summary of model totals and a
potentially highly detailed table for individual entities allowing the
engineer to dig right into the details of the calculations. The new report
tables ``Embodied Carbon Overview” and “Embodied Carbon Details”
are available from the drop list of tabular results at the top left of the
Review Data Ribbon tab, as shown in the picture below. Embodied
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Carbon Mass values are also included in a new column added to every
material list (Including the associated report item).

• Filtering - as for the existing tabular data reports, you can control the
new table content using the Ribbon filter buttons for Material Type,
Characteristic and Construction etc.

• Sorting - the tables also feature automated sorting by selected
column header - simply click the column header you wish to sort by,
then click it again to reverse the sort order, or click another header
to sort by that.

• Reporting - for rapid reporting, the currently configured table can
also be exported directly to Excel by clicking the Export Excel Ribbon
button. The Overview tables have associated report items and so
can also be included in a Report (see below).

• Locating - as with the Material List tables, you can locate in the
model the entity or entities associated with a row in the tables
simply by double-clicking the row. This will automatically activate the
Structure 3D view, then select, highlight and arrow the associated
entity/ entities. Together with the filtering and sorting facilities this
enables the engineer to rapidly home in on and locate entities with
high Embodied Carbon.
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• Embodied Carbon Overview - this features two additional button
controls below the drop list “Group by Plane” and “Toggle Selection”.
With Group by Plane active, Embodied Carbon totals are given for
each construction plane (commonly the floors). When off the total
are grouped by Characteristic e.g. Slabs, Beams, Columns etc (see
the first picture in this section above for how this looks). Toggle
Selection turns on/off all of the Ribbon filter buttons with a single
click, so the engineer can quickly set them all on to see the full
model results, or set them all off to begin a specific filter such as
Material = Concrete and Characteristic = Beams.

• Embodied Carbon Detail- this table has two levels controlled by the
“Summary Only” ribbon button which works in a similar manner to
the Material List tables;

• “Summary Only” on (the default) gives a brief summary table
giving the Embodied Carbon Mass quantity for each entity
together with their reference (for continuous beam/ columns/
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walls a reference and value are given for each span/ stack/
panel).

• Set the button off to see the Detailed level which gives a much
higher level of detail for every entity included in the table,
including Embodied Carbon quantities for the individual parts
and surfaces of each entity appropriate to the entity type. So e.g.
for concrete beams, for each span it gives quantities and
Embodied Carbon values for; Concrete, Coating and
Reinforcement. For steel composite beams it gives values for;
Steel, Coating, End 1 & 2 Connections (allowance), Shear
Connectors and (Transverse) Reinforcement.

• Reports - new report chapters are added for the Embodied Carbon factors
and both Overview result tables options of by Plane and Construction Type
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discussed above. The Overview tables are also included in a new default
Embodied Carbon report style (for new models started in this release).
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Further details on the above topics are also given in the new Help topic
Embodied carbon workflow.

1.9 New Fireproofing
Fireproofing is the application of fire resistant insulation material to the
surface of structural members (as illustrated in the picture below) in the form
of; protective paints, thin/thick film coating sprays, fire boards etc. This release
adds the facility to apply such fireproofing to all 1D members of the model
with the definition of its distribution, thickness and density. The fireproofing
increases both the weight and surface area of members. The additional
member self-weight is automatically calculated, reported and included in the
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analysis, and the resulting enlarged surface of the member is also considered
by the new Open Structure Wind Loading (page 32).

For the Eurocode Head Code, the fire resistance check settings are now
incorporated into those for Fireproofing - for more about the fire resistance
check see this Help Topic and the release note Steel Design - New Fire
Resistance Check to Eurocode EN 1993-1-2, Cl 4.2.4 - All NA’s.

• A new Fire proofing Property settings group is added as shown below left.
For members with fireproofing applied, enable the “Protected” option and
you can then specify all the required fireproofing details of; Shape (Contour
or Hollow encasement as illustrated below right - Contour on the left and
Hollow the right), thickness and density. The new properties are available
for all 1D member types/ materials (with the exception of; analysis
elements, DELTABEAM and FABSEC Beams)

• For the Eurocode and steel beams, if you also enable the fire resistance
check - which is optional - you can also set the Thermal conductivity and
Specific heat values used by this.

• Note that the calculated additional self weight is displayed at the
bottom of the new properties. This updates automatically to reflect
changes to the section size and/ or fireproofing values.
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• Review View - a new “Fire proofing” Attribute is added to the Review View >
Show/Alter State options, enabling rapid graphical review and editing of the
Fire proofing and resistance check settings.

• Review Mode - in this mode you can see a color-coded view + legend
showing the distribution of fireproofing and fire resistance check
settings throughout the model, as shown in the picture below.
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• Toggle/ Set On/Off Modes - using these you can quickly Toggle On/Off
either fire protection or the fire resistance check using the mouse for
single or multiple entities. In Set On mode for “check for fire resistance”
you can set on the check and optionally set the exposure level (all sides
or 3 sides) while for “Protected” you have options to specify all the
protection properties of; shape, thickness and density.
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1.10 New Automatic Backups
While Tekla Structural Designer has always had an Autosave feature which
provided additional file security to cater for unexpected PC/ program
problems this had some limitations. These are addressed in this release with
the addition of a comprehensive new Backup facility. This ensures that,
whatever happens, there can be previous versions of the model to revert to.
Another benefit is an automatic history of the model (limited by the
configuration settings - see below).

• The Backup configuration settings are in the Home > Settings >
Autorecover group as shown in the picture below. Via these you can:

• Enable/ Disable the Backup process via the Enabled check box - default
= enabled.

• Set the time Interval for backup creation - default = 30 minutes

• Define the backup Location directory - the default is your Windows
user profile Documents directory. Click the link to browse to your
preferred location (both local and network locations are allowed).

• Specify the Maximum number of backups per project - default = 10
(when the limit is reached the older backups start to be automatically
deleted).

Tekla Structural Designer 2021 release notes 29 New Automatic Backups



• Backup File List - the list of backup files for the currently opened model is
accessed from the new “Model Backups'' option in the File menu. This
opens a new dedicated Model Backups dialog listing all the current backup
files.

• Note that it includes the unique Model ID which is used for the model’s
specific backup directory name.

• Click the Backup path to open the backup directory in Windows
Explorer.

• The date and time of each backup file is added to the end of the file
name. The backup files are saved with read-only permission

• Similar to autosaves, backups are core saves of the model - they are
only created if, at the end of an interval, there have been changes
since last backup.
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• Using Backups for Recovery:

• Manual Recovery - this can be accomplished from the Model Backups
dialog or directly from Windows Explorer for numerous eventualities/
reasons.

• Handled Exceptions - in a process that has been in place for some time,
when a program error occurs a dialog is displayed when possible,
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prompting the user to select from a list of file Revert options - these
depending on when the error occurs and what previously saved/
autosaved files exist. Backup files can now be selected for reversion in
this eventuality:

• Where they exist, Backup files are now added to the list of options
via a new “Revert to automatic back up this model” radio button
option, this includes a drop list of existing backup files from which
you can select the preferred file.

1.11 New Open Structure Wind Load
This new feature adds a quick and effective way to apply wind load especially
for Industrial Structures which typically are not clad, though it can be used for
any un-clad structure or part. Application is simple and straightforward - the
existing Wind Wizard is used in essentially the same manner as currently,
other than there being no requirement to ‘clad’ the model with wall and roof
panels. The feature can also be used in conjunction with wind wall and roof
panels and has a host of user-defined settings, making it very flexible and
applicable to a wide range of structures and geometries. The method of
calculation for open structure wind loads we have developed follows both
general principles and guidance from the United States Loading code ASCE7
and the ASCE document ‘Wind Loads For Petrochemical And Other Industrial
Facilities’ (adapted for all loading codes). For more information on using the
feature and its load calculations, see the new Help Topic .

As shown in the picture below, the applied loads can be reviewed both via the
decomposed loads in the Structure View (enable Text for Loading >
Decomposed in the Scene Content settings to see values) and in the Wind View
(for a selected direction and loadcase). In the Wind view, the principal wind
load values of shape factor, wind pressure and applied wind force are
reported in the cursor tooltip of a selected entity. All the applied loads are fully
considered in analysis and design. For detailed information about how the
loads are calculated see the new Help Topic .

Tekla Structural Designer 2021 release notes 32 New Open Structure Wind Load



Tekla Structural Designer 2021 release notes 33 New Open Structure Wind Load



• Scope:

• Loaded Entities - Open Structure Wind Loads are generated on the
following entities: Structural Members (beams, columns etc), Line
Ancillaries, Area Ancillaries, Equipment (new for this release - see
below).

• Head Codes - applies to the United States, Eurocode (all countries) and
Indian Head codes. It is not currently available for the British Standard
BS 6399-2, or Australian AS:1170.2 wind code variants.

• Assumptions & Limitations:

• All wind loads are assumed to act perpendicular to the members,
equipment and ancillaries.

• Applicable for all 1D structural members irrespective of their
characteristic except; Analysis elements, DELTABEAM, FABSEC beams.

• Are not applied on structural walls (use wall panels over these to apply
load).

• Shielding effect is not considered.

• Does not consider frictional wind forces on any surfaces.

• Workflow - application of Open structure wind loads essentially requires
two simple steps; 1) specify which entities the wind load will apply to 2) run
the Wind Wizard and enable the new “Apply Open Structure Wind Load” It’s
as simple as that! In more detail:

• Review/ specify the entities to which the Wind Load is to be applied.
This is controlled by a new Wind loading > “Apply open structure wind
load” member/ entity property as shown in the picture below - when
this is enabled the wind loading is applied.

• You can carry out this step most effectively in Review View > Show/Alter
State using the new “Wind Loading” attribute which enables rapid graphical
review and editing of the setting. Simply Toggle or Set On/Off the setting by
individual mouse click and/or Window cursor operations (see picture
below).
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• The “Apply open structure wind load” property is enabled by default for
Ancillaries and Equipment and is off for structural members.

• Note that for continuous members it can be applied on a per span/
stack basis.

• You can additionally review/ edit - via entity properties - the listed wind
loading parameters Shape factor, Cf and Effective area XY and XZ factors.
See below for more on these.

• Run the Wind Wizard and check on the new “Apply Open Structure Wind
Load” - from this point forward the process of completing the Wind Wizard
and adding Wind loadcases is unchanged. Following this, the open wind
loads calculation and application is entirely automated.

• Additional aspects:

• Review View - as mentioned above, Review View > Show/Alter State
includes a new “Wind Loading” attribute enabling rapid graphical review
and editing of the “Apply open structure wind load” property via Toggle
or Set On/Off modes.
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• Shape factor (Cf ) and Effective area factors - new Global and Model
settings are added to set the default values for these, accessed via Global/
Model Settings > Loading > Wind Loading as shown in the picture below.
There are also Area/Length values for some ancillaries such as Walkways/
catwalks both with and without guardrails. Note the following:

• The default Cf factors are taken from the document ‘Wind Loads For
Petrochemical And Other Industrial Facilities’ published by ASCE.

• The settings also have columns showing the Effective Area equations so
you can see how these values are calculated.

• Factor values set/changed in Model Settings are applied to all entities in
the model. You can also set the value for an individual entity via its
properties.
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1.12 New Equipment Load Entities
New for this release Equipment Load Entities are similar in concept and
operation to the recently added Line and Area Ancillaries , for more about
which see the 2020 SP4 Release notes section New Line and Area Ancillaries
Loading. They enable the definition of three dimensional objects for the
purpose of load application for such items as retaining tanks, plant and
machinery etc. While developed principally with industrial structures in mind,
they may have wider application for tanks, plant etc acting on any type of
structure. As shown in the picture below, since (like Ancillaries) they represent
physical objects, they are applied via a new button added to the “Walls &
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Loading Objects” group of the Model tab of the Ribbon. They can be of three
principal shapes; Cuboid, Cylinder (Vertical & Horizontal) and Sphere.

They are also fully considered and loaded by the New Open Structure Wind
Loading (page 32) - For detailed information about how loads are calculated
and applied to them see the new Help Topic Wind load on open structures
calculations.

Key aspects of the new Equipment Loads are:
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• The Equipment entities do not form any part of the analysis model - only
the loads they apply take part in the analysis and are fully considered in
design.

• Definition - after activating the Model ribbon command, you create an
Equipment Load entity by clicking its “Support points” in turn, clicking twice
on the final point, just like creating a panel as shown in the picture below.
Any number of points forming any shape can be selected though, just as
for panels, they must all lie in the same plane.

• Prior to creating, select the Equipment type in the Properties Window and
enter the required parameters (which default to zero) for its size, base
position, z (vertical distance above support points plane), lateral offsets (if
any), loads and load application option - either “At CoG” (center of gravity)
or “At supports” . Just as for any physical entity, all these settings can be
reviewed/ edited via the Properties Window after creation by selecting
existing Equipment entities. Note the option to “Apply open structure wind
loads” which defaults to on.

• The support points for an existing Equipment entity can subsequently be
manually adjusted just as you can the vertices of any panel; select the
Equipment entity, click a support point (single click, not click-and-drag),
move the cursor to another point and click again to move it there.
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Adjustment points are also added between each support point, enabling
the addition of further support points, as shown in the picture above.

• Support point load calculation and decomposition - the support points
define a “panel” which is used to calculate (arithmetically) the support point
loads by assuming it acts as a rigid body and the load is applied at the
Equipment CoG. The load decomposition is potentially in two stages as for
Ancillaries; in the first stage the calculated loads are applied to the support
points, in the second phase these are decomposed - where necessary -
again by whatever supports these. For example in the case of a supporting
two-way slab - as shown in the picture below - this 2nd stage
decomposition will be in a two-way manner to the members supporting
the slab producing VDL’s and point loads etc as appropriate.

• Note that the calculation of the support point loads for lateral loads
(from Open Structure Wind Loads) accounts for the vertical offset of the
centre of gravity (CoG) of the Equipment entity, producing “push/pull”
point loads and thus an overturning moment on the supporting
structure.

• If you do not wish to use automatically calculated support point loads, you
can override this by selecting Apply load = “At Supports” instead of the
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default “At CoG”. As shown in the picture below, you can then directly enter
your own load values for each support point.

• You can also manually apply additional point loads - as dead/imposed and
in horizontal or vertical directions - to Equipment Entities using the new
“Equipment” load option in the Structure Loads group of the Load tab of
the Ribbon. The loads can be applied either to the Equipment CoG or
Support points.
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• Load Cases - dedicated Equipment loadcases are automatically created and
removed (just like for ancillaries) as Equipment entities are added/deleted
and can be included in combinations in the usual manner.

An additional setting in Global/ Model Settings > Loading > General controls
the load Type for the Equipment Operating Content and Testing Content
loadcases which can be set to either Dead or Imposed (similar to pipework
ancillaries).
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1.13 New Partially Cracked Concrete Walls & Members
This new feature is an addition to existing features of especial use in the
design of tall buildings, for which the engineer needs to particularly assess and
modify the stiffness of the lateral force resisting system - commonly
composed of concrete shear walls - to control lateral displacements. The
stiffness of concrete members is determined in large part by their state of
cracking - which can vary between the ‘extreme’ conditions of entirely
uncracked and fully cracked. All previous releases have had the option to
specify the (fully) cracked and uncracked conditions for concrete members
(beams, columns and walls) and control their stiffness accordingly and
separately via Modification Factors. Note the default values of these for the
Building Analysis assume the loading is long term and should be modified
when considering short term loading - for more see this TUA article: Where do
the default values for cracked and uncracked properties of concrete come
from?

This release adds a further refinement to modeling the effect of cracking on
stiffness with a new partially cracked option for the intermediate condition
between (fully) cracked and uncracked which is applicable to beams, columns
and walls (meshed). The partially cracked state is set by a simple degree of
cracking % for which the stiffness modification factor is automatically
calculated and applied. For more see this Help topic:

Tekla Structural Designer 2021 release notes 43 New Partially Cracked Concrete Walls & Members

https://teklastructuraldesigner.support.tekla.com/support-article/2746305
https://teklastructuraldesigner.support.tekla.com/support-article/2746305
https://teklastructuraldesigner.support.tekla.com/support-article/2746305


• Tall Building Companion Features - as mentioned, this feature adds to
and can be considered in the context of a number of more recently added
features targeted particularly at the design of tall buildings. These are:

• Dynamic Analysis - Wind Tunnel Data Report Generation

• Design for high strength concrete grades (Eurocode) - for more on this
see the Design section in Tekla Structural Designer 2019i Release Notes

• Stresses in 2D elements

• 2D In-Plane Stress Contouring useful for assessing extent of cracking of
Concrete Walls

•

•

• Key Aspects of the new feature are:

• Scope - the feature is applicable to:

• Wall type: Meshed shear wall (not mid-pier), Material = Concrete,
Fabrication = Cast in place & precast

• Beams - Material = Concrete, Fabrication = Cast in place, Post
tensioned & precast

• Columns - Material = Concrete, Fabrication = Cast in place & precast

• New Property Settings - the properties for walls, beams and columns
are adjusted for the new feature; the “Assume Cracked” setting is now
listed in the “Analysis & design control“ group (previously “Design
Control” for beams and columns) and a further option “Partially” is
added. When this is selected you can enter the degree of cracking as a
% from zero (fully uncracked) up to 100% (fully cracked).
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• Partially cracked modification factor - the partially cracked
Modification Factor (ModFactorPartially Cracked ) is automatically calculated
by linear interpolation for the specified percentage (x%) between the
factors set for uncracked (ModFactorunCracked) and cracked
(ModFactorCracked) as follows:

• ModFactorPartially Cracked = ModFactorunCracked - x% *
(ModFactorunCracked - ModFactorCracked)

• • Thus for example for the default short term (Modal Analysis & RSA)
concrete meshed wall modification factors of cracked = 0.5 and
uncracked = 1.0, a Partially cracked value of 50% gives a modification
factor = 1.0 - 0.5*(1.0 - 0.5) = 0.75.

• Member stiffnesses are then automatically adjusted by the
interpolated partially cracked modification factor values, these being
calculated and applied for every property pair for which different
values are specified for cracked and uncracked (specific to the factor
values currently set in the model), thus:

• Meshed Walls - the interpolated factor applies to properties E, G
and/ or t as appropriate in the same manner as the cracked/
uncracked factors.

• Beams & Columns - the interpolated factor applies to the section
properties as appropriate in the same manner as the cracked/
uncracked factors.

• Review View > Show/Alter State - the controls for the “Assume
cracked” attribute are enhanced to allow review, application and editing
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of the new partially cracked setting as illustrated below. While the
pictures show the review/ settings for walls, the functionality for
concrete beams and columns is the same.

• Mode options are adjusted - a new “Review” mode is added (in
addition to Review wall stresses) and the editing options are now
“Toggle” and “Set On”.

• Review Mode - In Review Mode the color-coding and legend are
enhanced to show the distribution of applied partially cracked
values. With this mode active, the cursor tooltip also includes the
Partially cracked % value and calculated EI values for major and
minor axis inertia*.

• *Note that the EI values are for illustrative purposes only, should
you wish to compare them with your own calculated values - the
analytical adjustment of stiffness is made by application of the
partially cracked modification factors as discussed above.

• Set On Mode - when enabled a new “Assume cracked” option is
displayed with the edit options of “Yes”, “Partially” and “No”. With
“Partially” selected, you can check on the “Set Percentage” option
and enter your desired % value. This can then be applied graphically
to the model using mouse operations. As shown below, the color-
coding and legend adjust in relation to the current % value to show
you where it is currently applied, the distribution of other % values
and Uncracked/ Cracked.
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1.14 New Steel Column Base Plate Connection Modeling &
Design - Eurocode and USA Head Codes
In this release it is now possible to explicitly model and design steel column
Base Plate Connections to the Eurocode and USA Head Codes within Tekla
Structural Designer. The design is carried out and reported fully within the
program, with no use of Tekla Connection Designer (TCD), as shown in the
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picture directly below. For full details of this new feature see the Help topic
and this related video.

• New/ changed operation - base plates will be added (or can be created) in
this release for steel columns for all Head Codes and will be listed in the
Structure Tree as described below. Other changes are dependent on the
Head Code as follows:

• Eurocode - base plate connections are no longer listed in the
Connections tree (after running the Update Connections command/ for
existing models in which this has been done). Additionally, for the UK/
Irish Eurocode NA, they can no longer be exported to TCD for design
(TCD can still however be used on its own if you wish).

• United States - base plate connections are no longer listed in the
Connections tree (after running the Update Connections command/ for
existing models in which this has been done).

• British Standards - as currently, base plate connections can be added
but are not designed directly in Tekla Structural Designer. They can be
designed in Tekla Connection Designer (TCD) - either integrated within
Tekla Structural Designer or via export. New in this release is that they
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are listed in both the Structure Tree and the Connections Tree. For
more information see the Help topic:

• Australia & India - as currently, base plates cannot be checked in Tekla
Structural Designer or designed in TCD.

• Modeling - to enable base plate connections definition, Bolts/ Rods and
Weld data is added to the database in this release (see picture below). The
bolt/ rod data includes all the required dimensions and design strengths
required for design, while the weld data is in terms of the leg length size
and, for the USA Head Code, the electrode strength. You can add to and/ or
make your own named copies of bolt/ rod sizes and add your own welds
data should you need to.

• Note that base plates and anchor plate Width & Thickness are taken
from the existing Plate Dimensions in the Sections Database.
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• Creation - base plate entities are now automatically added on creation
of a new steel column when it requires a support. Base plates can also
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be manually created using the new Add Base Plate button on the
Design tab of the ribbon (final button on right of ribbon).

• Adding base plates works like adding pad bases - you can click on
either the column or its support, or window over a selection of
multiple columns/ supports. A column which has no support cannot
be selected for application.

• When a pad base (spread footing) also exists at a column
support, the base plate connection’s concrete base properties
are automatically populated from this.

• Existing Models - the process and workflow for existing models created
in prior releases depends on the scenario, of which there are three:

• No base plate connections exist - you can add them manually as you
need as described above.

• Base plate connections already exist (the Update Connections process
has been run previously) but have not been sized/ designed (using
TCD) - when opened in this release, the existing base plate
connections are automatically listed in the Structure Tree (see
below) and their properties populated. They will no longer be listed
in the Connections Window of the Project Workspace (Eurocode and
USA Head Codes). The “Autosize” property for them will be off and
you can enable it if you wish (recommended - see below) to obtain
initial sizing.

• Sized/ designed base plate connections already exist (Eurocode
Head Code models only) - the same process described above occurs
and again the base plate “Autosize” property will be off - you can
leave it in this state to retain all the sized connection properties. The
base plate’s design status will be reset and you can then run a check
to update this (see below).

• Base plates can be selected, moved, copied and deleted - either singly
or a selection - just like other entities. Also like other entities, they have
a full set of properties which can be accessed for review/ editing both
via a dedicated dialog - as shown below - and via the Properties Window
for a single or multiple selection.

• Since they are associated with a column, when selecting a column to
move/copy/delete the base plate, as default, will be selected also
(just as a column support is) - you can then choose to only move/
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copy/delete the column by de-selecting the Base Plate from the
associated operation dialog.

• Base plates are also automatically listed in the “Members” group of the
Structure Tree, grouped by their column section size. As well as
selecting base plates here, it is also possible to run a check design of
them via the right-click context menu as shown in the picture below.
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• Autosize - this key property of base plates is enabled by default when
they are created. This uses simple geometric rules to produce an initial
valid and sensible base plate size and configuration for the column’s
section size. When the column's section size is changed - for example by
an auto-design - the base plate is adjusted accordingly.

• The autosized base plate is not guaranteed to be adequate so this
should not be confused with auto-design. The engineer will typically
need to manually configure the connections - in terms of plate size
and thickness, bolt size and layout and weld sizes etc - then run a
check to assess if they are adequate.

• Design Process - as mentioned above, the design process is essentially
manual configuration and check-design. Once the column section sizes
have been established with autosize enabled, this setting can then be
turned off and you can make further manual edits to the base plate
properties should you wish to. All base plates can then be checked in a
single process via the new “Check Base Plates” button on the Design
Ribbon. You can also run design for some or all base plates from the
Structure tree as shown in the picture above, as well as for individual base
plates via the right-click context menu.

• Property Sets - note that Property sets can be created for/ from and
applied to base plates, just like with other entities in Tekla Structural
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Designer - so you can use these to rationalize your design for similar/
typical base plate connections.

• Review View - base plates design results are available with other
members via the main Design group of the Review View Ribbon, (not the
Connections ribbon group), so you can quickly visually review their
design statuses and ratios. The recently added (in 2020 SP6) Review
View Entity type filter for Connections can be enabled to focus the view
only on base plate design results as shown in the picture below. For
more about this feature see Review View - Design Status Enhancements

• Design Scope & References - these are as follows depending on the Head
Code:

• Eurocode - the design covers all Eurocode Country NA variants and the
checks follow the SCI design guide ‘Green Book’ P358 so the scope is:

• Connection type/ configuration - Simple (i.e. no applied moment)
column bases only for I, H or hollow section columns and steel
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grades S235, S275, S355 & S460 (the default grade for base plate is
S355). No eccentricity of the column to the base plate is allowed
(ebpz = 0).

• Design forces*; axial compression and major axis shear (Warning or
Beyond scope messages will be issued where these conditions are
not met). All load combinations are considered except EQU, GEO,
and SEIS combinations from RSA.

• Design checks - Base plate size (Effective Area Method), Shear and
Welds capacity

• *Note that, unlike for the previous export of column base plates
to TCD, the minimum design forces (Design > Settings > Design
Forces) are not considered for design within Tekla Structural
Designer hence all non-zero forces from analysis are considered.

• United States - design checks are per AISC DG1, AISC 360 (05, 10 & 16)
and ACI 318 (08, 11, 14 & 19) and the scope is:

• Connection type/ configuration - Simple (i.e. no applied moment)
column bases only for W, M or hollow section columns for all steel
grades (default grade for base plate is A36-36).

• Design forces; axial compression only. All load combinations are
considered except seismic from RSA.

• Design checks - Base plate Bearing Strength and Plate thickness.

• Drawings & Reports:

• Drawings: Base plates are now included in the following drawings
(*anchor plates applicable to Eurocode only):

• GA drawing - the following information is included; Base Plates,
Bolts/Rods, Base plate & bolt/rod details*. Note that the 2x column
scaling option applies to base plates also. See picture below for an
example (Eurocode).

• Non-concrete column drawings - both In elevation at the bottom of
each column view (minor & major) and In plan (x4 scale in order to
clearly show bolt layouts) with the following information included;
Base plate, Bolts/Rods, Grout, Welds, Anchor plates*, Base plate,
bolt/rod, grout & anchor plate details*. See picture below for an
example (Eurocode).

• New Dedicated Base Plate Drawing - a dedicated Base Plate Member
Drawing as been added with the following information shown in
elevation & plan where applicable: Base plate, Bolts/Rods, Grout,
Welds, Anchor plates*, Concrete base, Base plate, bolt/rod, grout,
concrete base & anchor plate details*

• To control these new items and drawing, new associated layers have
been added to Draw > Settings which are on as default in the
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settings sets for this release. Layer styles and configuration can be
adjusted as required.
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• Reports - base plates output can now be included in reports as follows:

• Model Report - new Base Plates and Base Plate Design Summary
report items have been added to Model Report > Chapters and
options. The Base Plates item adds the Member Report for all base
plates in the model (see below) and the Summary produces a simple
condensed table with a single row for each base plate giving the
main dimensions, number of bolts, UR and overall design status as
shown in the picture below.
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• Member Report - a new Member report has been added for base
plates which can be configured and generated in the same manner
as other member reports, both individually and included in the
model report. The Member Report dialog now includes a “Base
plate” member type which has default Design and Design Summary
styles as for other member types and these are configured in the
same manner. The report includes the new Base plate detail
drawing (by default) and an example of the output this gives is
shown below.
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• Material List - base plate quantities can also be included in the
Material List Report with the following information included
(controlled by the Material List > Options > Steel settings); Plates,
Bolts and Anchor Plates*.

1.15 Enhanced Sway/ Drift/ Wind Drift & Seismic Drift
Check Control and Reporting - All Head Codes
The control settings and reporting for the Sway/ Drift/ Wind & Seismic Drift
Checks have been thoroughly updated and enhanced for this release in line
with customer feedback. All these checks assess the relative lateral deflections
of successive levels - resulting from lateral loads of various kinds - and so their
results and reporting requirements are similar. Tekla Structural Designer has
always performed these checks very thoroughly in line with the design code
intent by assessing the deflections of all columns and walls (where not
specifically excluded) on a stack/panel basis and also reported the results on
this basis. While this does follow the code requirements, they generally
describe these checks in terms of levels - rather than stacks/panels - and with
one check per level rather than many. Hence the sway results as previously
presented were potentially less in line with the engineer’s expectations, over-
complex and difficult to efficiently assess. This is addressed in this release as
follows:

• Common Changes - all the Sway/ Drift/ Wind Drift & Seismic Drift check
results in all reporting locations are now presented in terms of levels rather
than column/ wall stacks/ panels.

• Level Check Control - there is now a single control in Level Properties
“Check for drift” as shown below left. This is only listed for levels set as
floors and when enabled removes the level from the check reporting for
all sway/ drift checks (although the checks are still performed for stacks/
panels above/ below it).

• Status Window Sway/ Drift Results - the check Warning and Fails
status for these results in the Design Status group are now grouped by
Level as shown below right - each level group lists the individual
columns/ walls with the status for that level. This can indicate
immediately the level(s) where sway/ drift is a problem while the
previous result display did not.
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• Accessing Sway/Drift Review Views - the Review Data Table and Show/
Alter State Views can now be opened directly from the Status Window as
shown in the picture below - just right-click over a Warning/ Fail message in
the sway/ drift results tree and select to open either its associated Review
Data Table or Show/Alter View from the context menu. The Show/Alter
State Views automatically open with the Review Mode activated.
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• Sway/ Drift Review Data Tables - these are similarly improved as shown
in the pictures below comparing the 2021 (Eurocode) Sway results to those
in previous releases. The results are now reported by level, producing a
more compact results table where problematic levels are immediately
apparent. While the picture below shows the (Eurocode) Sway results table,
all Sway/ Drift, Wind Drift and Seismic tables for all Head Codes are
similarly improved.

• Similar to the Material List and Embodied Carbon tables, the sway/ drift
result tables now have two levels - Summary Only and Detailed -
controlled by the “Summary Only” toggle button directly below the table
drop list at the top right of the Review Data ribbon tab. The Summary
Only option (default) lists only the critical columns/ walls stacks/ panels
for each level. Set the “Summary Only” toggle button to see results for
all columns/ walls stacks/ panels (sorted by level).

• In a similar manner to the Material List and Embodied Carbon tables,
you can also now double-click on a row in the sway/ drift review tables
to locate the associated column/ wall stack/ panel in the model - doing
this will automatically switch to the 3D Structure view, select and arrow
it.

• Note that results for both columns and walls can now be viewed
simultaneously in a single table where previously they could only be
viewed separately.
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• Show/Alter State Views - the Review Mode view for these is improved to
give results on an individual stack/ panel basis (for all Combinations), again
giving a much clearer indication of where sway/ drift problems are located
as shown in the picture below. Where previously the entire column/ wall
was assigned the critical status/ color, now each stack/ panel is assigned its
own individual status/ color. This is controlled by the “Entire Member”
Mode option which is enabled by default. You can check this off to see a
view similar to previous versions with the entire column/ wall having the
status/ color of the critical stack/ panel. While the picture below shows an
example (Eurocode) Sway results view, the views for all Sway/ Drift, Wind
Drift and Seismic results for all Head Codes are similarly improved.

• The legend is also expanded with more statuses including “Not
Required” for stacks/ panels for which the sway/ drift check has been
turned off.

• The following additional improvements are made for the Toggle and Set
On/ Off modes used to set the sway/ drift check on/off for selected
members. Again this applies to all sway/ drift checks and Head Codes.

• These modes can now be used for walls where previously only
columns were available.

• An Entity Type filter has been added to specify which entities can be
selected for the current operation with options of; All, Columns,
Walls.
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• Wind Drift - some specific improvements are made to the settings and
checks for Wind drift, again in line with customer feedback.

• Wind Drift Limit - a new Wind drift ratio limit value control is added in
Design Settings > Sway & Drift Checks as shown below. This allows the
engineer to set the drift limit for the entire model in a single step, where
previously this was set on an individual column/ wall and span/ stack
basis.
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• The column/ wall properties are changed accordingly also - in place of the
previous limit value, there is now an “Override…” checkbox. This is off by
default, in which case the value set in Design Settings is used. When
enabled you can enter your own limit value - again on an individual
column/ wall and span/ stack basis.

• The Review View > Show/Alter State Wind Drift controls for the “Set On”
mode are also enhanced accordingly; options are added to enable the
override option and set the limit value for selected members. The view
color-coding and legend update to reflect this operation for the current
drift limit value to show; members with the current override applied, those
with other override values and the default (set in Design options), as shown
in the picture below.
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• Resultant Wind Drift - to cater for wind loads/ resulting displacements
being at some intermediate angle w.r.t. the building directions, a new
Design setting has also been added to set the Wind Drift check to consider
Resultant (i.e. square root of sum squared) drift values, rather than values
for each building direction separately as previously, as also shown in the
picture above right. This is on by default and, in conjunction with the
enhancement detailed above, produces a much more immediately useful
and compact results table, as illustrated in the picture below. Simply set
the new setting off should you wish to see check results for each direction
separately.

• Note that you can also now select individual load combinations to
review their results via the combinations drop list at the bottom right of
the program window as shown below. By default this is set to “All
Combinations”, giving the critical results considering all combinations.
In recent previous releases this was the default setting and could not be
changed to view individual combination results.

• The check details report the derivation of the resultant deflection and
drift values when this setting is enabled.
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• Reports - all the associated report items for the sway/ drift checks have
also been updated accordingly to encompass the improvements detailed
above. It is thus now possible to obtain much more succinct and clear
sway/ drift reports.

• The configuration settings for the Wind Drift item are also changed to
reflect the enhancements as shown below - the options for reporting
only critical stack/ combination are removed as no longer required.
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1.16 New Reinforced Concrete Design to ACI 318-2019 - US
Head Code
ACI 318-2019 is added to the Resistance Codes available for USA Concrete
Design. The scope essentially matches that of the existing 2008, 11 and 14
versions for Static and loading, and applies to all the following concrete
elements; Reinforced Concrete Beams, Columns and Walls; Reinforced
Concrete Slab Panels, Slab Patches and isolated Punching Checks; Reinforced
Concrete Spread and Strip Footings, Pile Caps and Mat Foundations. Design
for Seismic loading is covered for; Beams, Columns and Walls. There are many
detail changes incorporated in the update in accordance with the new code
version - for full details of these please see the new Help Topic and its
subtopics. We include just a few highlights and items of note here.

• General:

• Clause 20.2.2.4 of ACI-318-19 makes a revision to reinforcement
strength, limiting it to 100 ksi. Accordingly a new 100 ksi reinforcement
grade with common bars sizes has been added to the Materials
database.

• As per Table 21.2.2 - For tension controlled sections the strain limit is
revised from 0.004 to єty + 0.003. This is reflected in updated design
calculations wherever required in the calculation of flexure checks.

• Clause 19.2.1.1 has added a minimum compressive strength (fck) check.
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• Concrete Column Design - Clause 22.5.5.1 introduces revised shear
equations while Clause 22.5.1.10 adds a new biaxial shear check; column
design is updated accordingly to these.

• Clause 22.5.5.1 changes - account for size effect and for low longitudinal
reinforcement ratios for members without shear reinforcement. The
design equations are simplified ( 8 Equations ➝ 3 Equations). The
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changes of this clause are also reflected in revised sectional shear
checks for other entities such as walls, slabs and foundations.

Tekla Structural Designer 2021 release notes 74 New Reinforced Concrete Design to ACI 318-2019
- US Head Code



• Clause 15.4 is implemented which adds a joint shear check for static gravity
loads, in line with that for seismic design.

• Seismic - the revisions of Clauses 20.2.2.4, and 19.1.1 to reinforcement
strength/ yield strength and minimum compressive strength check
respectively are also implemented in seismic design for beams, columns
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and walls as appropriate. Design specific to the entity type is also updated
in several areas accordingly:

• Beams - design implements the following clauses; Cl. 18.6.3.1, 18.8.2.3
and 18.6.4.4.

• Columns - design implements the following clauses; Cl. 18.7.3.1,
18.8.4.3, 18.7.5.3, 18.8.3.1, 18.7.5.5 and 18.4.3.3

• Walls - design implements the following clauses; Cl. 20.2.2.4, 19.2.1.1,
18.10.3.1 18.10.6.4(e) and 18.10.6.5

1.17 Foundation Design - New Lateral Load Check for Pile
Caps and Piled Mats
This release adds the ability to check the piles of Pile Caps and Piled Mats for
lateral loads (previously only vertical loads were checked). This enhancement
applies to the following Head Codes; Eurocode (all countries), United States
(ACI), India and British Standards.

• New Settings:

• Pile Catalogue - you can now specify the lateral pile capacity as shown in
the picture below.

• Design Settings - the lateral load check is activated by a new Concrete
Design setting “Check piles for lateral load” (default is off) as shown in the
picture below. There are separate settings for Isolated Foundations (Pile
caps) and Mat Foundations in Concrete > Cast-in-place > Foundations.
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• Design Checks - the design details are enhanced to display the results of
the new checks:

• Pile Caps - the new “Pile Lateral Capacity” result group has both a
summary table giving the results for the governing combination and
check details for all checked combinations for all analysis types.
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• Pile Mats - all individual pile design details include a new “Pile Lateral
Capacity” giving the check details for the governing combination for each
analysis type.
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1.18 Design Using Tekla Portal Frame Designer -
Improvements for Class 4 Haunches - Eurocode
For those designing steel portal frames to the Eurocode (UK and Irish NA’s),
there is a new companion release of Tekla Portal Frame Designer which
features significant enhancements to the classification of haunches, in
accordance with customer feedback. The Eurocode introduced tighter rules for
section classification on the Class 3/ Class 4 boundary which resulted in many
haunches that were adequate to BS 5950 being Class 4 at the deep end to the
Eurocode. This resulted in a 'Fail' because Class 4 sections are not dealt with in
Tekla Portal Frame designer. A number of improvements to the classification
rules and equations are made in the new release to mitigate the occurrence of
Class 4 haunches. For full details please see the Tekla Portal Frame Design 21
Release notes and Improvements to classification of haunched rafters to EC3.
Briefly the enhancements are:

• Haunch Web Slenderness - calculation of the slenderness ratio c/tw now
includes the rolled section root radius thus reducing slenderness e.g. for a
405x140x46 section c/tw reduces from 56.0 to 53.0

• Strength Check - Strength is checked at five positions with the first position
now accounting for the end plate thickness.

• Classification of moment + axial - the combined compressive stress is
‘normalised’ to fy, by increasing the bending stress while axial stress
remains constant.

• Class 4 Design Status - when the haunch web is still Class 4 this is accorded
a Warning rather than Fail status (note this applies only to the haunch web
not that of the rafter). The design process is completed assuming the
section is Class 3 - the designer can discuss this circumstance with the
checking authority.

• Cross-section Strength Checks - classification now includes the more
favourable provisions of Cl. 5.5.2(9) in which calculation of ε is based on the
actual stress rather than that of grade S235.

1.19 Other Enhancements and Fixes

Tekla Structural Designer 2021 release notes 79 Design Using Tekla Portal Frame Designer -
Improvements for Class 4 Haunches - Eurocode

https://teklastructuraldesigner.support.tekla.com/support-article/3083897
https://teklastructuraldesigner.support.tekla.com/support-article/3083897
https://teklastructuraldesigner.support.tekla.com/support-article/3083890


General & Modeling
• A number of additional fixes which are not detailed explicitly here are also

made to improve general performance and stability. An example of this is
given directly below:

• [TSD-8916] - Solver model - the meshing of wall panels is improved to
better handle connection to supporting columns and beams at corner
nodes which, in some circumstances, could produce errors preventing
analysis and design completion. For the circumstance of the wall corner
node being inside a column section, the connection is now made in
preference to the column, avoiding any beam rigid zones also within the
column section.

• Note that due to these changes, some existing models with rigid
zones turned off will have the existing analyses invalidated
automatically on opening in this release so these analyses must be
re-run.

• [TSD-6878] - Views - Selection Display - the display of selected objects is
improved to aid visualization and modeling as illustrated in the picture
below. Where selected objects were previously alway opaque (below left) -
thus obscuring the graphical information within their area - they can now
be transparent (below right) allowing you to clearly see entities and grid/
construction lines when, for example, making graphical edits to such
entities as panels (of all types).

• Selection transparency is controlled by a new setting Home > Settings >
Scene > Graphics > Selection Style with option of “Transparent +
Outlines” (default) and “Opaque” (previous behaviour).

• Slabs - additionally, when selecting slab items, only the individual slab is
now colored with the selection color, rather than the entire slab as
previously.
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• [TSD-7659 & 7660] - Wall Panels - a new General 'Rectangular' property is
added to wall properties (listed at the top Properties window during wall
creation) the default for which is on. This facilitates the modeling of
rectangular walls - when active you need only click on any two opposite
corners of the panel shape to create a wall in a 3D view. The new setting
should also help prevent the unintentional modeling of non-rectangular
walls (by inadvertently selecting a slightly incorrect construction point/
intersection during modeling).

• The new setting applies to all wall panel types as follows; Concrete
Meshed walls, Concrete Mid-pier walls (can only be rectangular so the
setting cannot be disabled for these), General (meshed) walls, Wind
walls.

Tekla Structural Designer 2021 release notes 81 Other Enhancements and Fixes



• Note that the new setting also applies when graphically adjusting the
corner nodes of wall panels as illustrated in the picture below - after
you have selected a wall panel then one its corner nodes, the Properties
Window changes to show only the Rectangular edit ‘mode’ option. This
will be checked on by default for a wall created with the setting on, and
off otherwise. You can then enable/ disable this setting as you require -
when enabled the wall shape remains rectangular and only a single
node needs to be moved to another point to adjust the wall height and/
or width, the top of the wall remaining horizontal.

• [TSD-7837 & 8545] -Member & Wall Properties - Height/ Length information
- the Properties Window data and entity tooltip information for selected
members/ walls are enhanced to include the length/ height of selected
entities, so you can quickly see this without needing to search in properties
or measure it. The new information is added in a number of locations as
detailed and illustrated below:

• Columns and walls - the stack/ panel height is shown in brackets
adjacent to each stack/ panel properties group (continuous columns/
walls) and also in the properties for each stack/ panel or the single
stack/ panel.

• Beams - the span length is shown in brackets adjacent to each span
properties group (continuous beams) and also in the properties for
each span or the single span.
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• Tooltip - the information is also added to the cursor tooltip displayed
when it is over an entity in a view; for walls the Length and Height is
now included and for line elements the Length is included.
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• [TSD-7722] - Slabs - Direction - to make it clearer and aid with modeling of
slabs, the direction angle property of two-way spanning slabs is now
termed “X direction”, as illustrated in the picture below. This also shows
how the X direction corresponds with the span direction icon for two-way
slabs; the blue icon arrow shows the X direction, the angle being measured
from the horizontal on plan.

• The text displayed for the property when it is selected now also explains
its significance; “X direction - Used for analysis and reinforcement
alignment”.
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• [TSD-7722] - Slabs and Wall/ Roof Panels - the span direction of these can
now easily be graphically edited, in both 2D and 3D views, using the mouse
as follows (applies to both one-way and two-way spanning and all slab/
wall/ roof panel types):

• Step 1 - select the slab/ panel item.

• Step 2 - select the span direction icon.

• Step 3 - the Properties Window now lists the direction mode options of
“Align with edge” and “Define by 2 points” - select the desired mode.

• Step 4 - select either a slab edge (of any slab item) or two points,
depending on the selected mode, and the slab direction will
automatically be set to the appropriate angle.
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• [TSD-7636] - Steel Cellular Beams - Cellular beams have been added to the
list of steel section types available for Thailand when this country is
selected in the Select Section dialog. This allows users to build their cellular
beam section database specific to this country, making them readily
available during modeling when selecting section sizes.

Interoperability
• BIM Integration - Tekla Structures -there have been significant

improvements to integration with Tekla Structures for the 2021 releases,
especially for the transfer of rebar design intent information from Tekla
Structural Designer to Tekla Structures. For optimum integration install
both this release and Tekla Structures 2021 on the same computer. For
more information please see the Tekla Structures 2021 Help Topic Tekla
Structural Designer Import and Export. Please note the following:

• For optimum performance of rebar transfer to Tekla Structures, ensure
you set the following In Structural Designer; in Model Settings >
Structural BIM > Export > Continuous Objects ensure the following are
enabled:

• Separate objects for each stack > Concrete columns

• Separate objects for each span > Concrete beams

• Separate objects for each panel > Shear walls
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• Remoting API - first featured in the 2020 release, the Tekla Structural
Designer Remoting API provides an interface for different kinds of
applications to interact with the analysis model and results in Tekla
Structural Designer. For more about using the API please see the getting
started page in the Tekla Developer Centre. The API is further enhanced in
this release as follows:

• In terms of data extraction it provides access to:

• Forces, displacements, camber and ecc. moments from member
loading analysis at zero, max and any other position.

• Additional results (wall and result lines, vibration and buckling
analysis, seismic RSA).

• Foundation reactions for RSA seismic and envelopes.

• Construction points, point groups, levels, frames, slopes, slab items,
slab openings, slab patches, slabs, roofs, structural walls, wind walls,
supports, piles.

• Architectural grids and construction lines.

• In terms of model creation it allows:

• Model and horizontal construction planes.

• Architectural grids and construction lines.

• Construction points.
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• Analysis elements.

• It is also now possible to access the API remotely through a LAN or
WAN.

Performance
• [TSD-4597] - Load Cases/ Combinations dialog - when making changes to

the checkbox settings (such as “Active” for example) for a selection of a
large number of combinations, the update process could take a significant
amount of time in previous releases, during which it seemed the program
was not responding (potentially up to several minutes where there were
200+ combinations). The time taken in such a case is now reduced to
around 1s or less. This is a general improvement which applies to all similar
list activation/ deactivation options within the program, but is likely to be
most apparent in the load combinations dialog where a large combination
list is relatively common.

Loading
• [TSD-7779] - Ancillaries - Imposed Load Cases - for the Eurocode (all

Country NAs), the ψ and ϕ factors of the automatically created Ancillary
Imposed load cases now have the following default values ( which were
previously zero); ψ1 = 1.0, ψ2 = 0.9, ψ3 = 0.8, ϕ = 1.0. This also applies to
those of the new Equipment Load entities introduced in this release.

• The engineer may wish to use different ψ / ϕ factors for certain
Ancillary/ Equipment loads. This is also now enabled in this release by
the addition of a new property setting for the Imposed Loadcase with
options of ‘default’ and a list of the existing other imposed loadcases, as
illustrated in the picture below for an Area Ancillary (also applies to Line
Ancillaries and Equipment loads). This operates as follows:

• When set to “default” the operation is as previously - the imposed
loads are included in the automatically created imposed loadcases
(which will be created if they do not already exist).

• Otherwise you can select from the list of existing imposed loadcases
to include the Ancillary/ Equipment imposed loads in one of these
(the automated imposed cases will not be created if they do not
already exist).

• For Pipework Ancillaries and Equipment loads, the new Loadcase
option is only listed when the setting for their Operating & Testing
Content Loadcase Type is set to “Imposed” in Model Settings >
Loading > General.
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• [TSD-8425] - Snow Loading - US Head Code - a new property for snow drift
loading "Do not apply balanced load" has been added to improve the
application of multiple drift loads to the same roof panel. Previously it
could be difficult to correctly size subsequent drift loads after the first drift
- which included the balanced load - was defined. The operation of the new
setting is as follows:

• New models/ drift loads - the first drift applied to a roof panel has the
balanced load applied so the new setting is disabled. For any
subsequent drift loads applied to the same roof panel, the setting is
automatically enabled so it does not have the balanced load applied but
uses that of the first drift to determine its drift load and extent. This is
illustrated in the picture below.

• Existing models - you can enable the new setting for existing
subsequent drifts and turn off Balanced load “Override load value”
setting to correct these if necessary.
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Validation
• [TSD-6123] - Validation Status - an inappropriate Validation status

“Validation is outdated” message could be issued following certain
operations that did not affect the status. This applies to the following
operations and is fixed in this release; Slab design, Slab patch design,
Punching check design, Report content editing (either model or element),
Pad base design, Pile cap design, Design Mat.

• [TSD-7596] - Wall Panels - a new validation check has been introduced in
this release for the shape/ orientation of wall panels to flag cases where
they are not quite rectangular and/ or vertical, since such situations are
probably due to modeling errors. When this situation occurs a new
validation warning is now issued; "Wall panel almost but not exactly
rectangular and vertical". The warning will be issued in the following cases:

• A side edge that is between 1mm and 50mm out of true vertical, or

• A top/bottom edge that is between 1mm and 50mm out of true
horizontal.
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• Note that a new 'Rectangular' property is also added to wall properties
(default 'on') to help prevent the unintentional modeling of non-
rectangular - see the details for issue TSD-7659 & 7660 in the General &
Modeling for more on this.

Design - General
• [TSD-8468] - Review View - Design Utilization Ratio (UR) - the legend

banding and colors are adjusted to improve the clarity of the view as
follows:

• Legend banding is changed so that everything below 50% is in single
group (accessed via Home > Settings > Scene > Utilization Ratio)

• The colors are changed such that green indicates a ‘good’ UR condition
(applies to UR > 0.9)
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• [TSD-3382] - Interactive Concrete Design - Column & Wall Tie/ Link Spacing -
All Head Codes - the design summary table in the shear design related tab
of the interactive design dialogue (titled “Ties” or “Links” for columns,
depending on the language set, and “Lateral” for walls) for reinforced
concrete columns and walls has been enhanced to now report required
areas of reinforcement and reinforcement utilization ratios where these
were missing previously. The enhancement also ensures that the design
Pass/Fail status is consistent between the check details and the interactive
design dialogue.

• [TSD-7238] - Pile Caps - All Head Codes - a new iterative analytical method
of distributing loads to multiple support points assuming rigid body
behavior has been developed for this release and is now used to calculate
the pile loads for isolated foundation Pile caps. This is expected to produce
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somewhat different pile load distributions for asymmetric pile layouts to
the method used in previous releases*.

• *We would note that all practical analytical methods of calculating the
distribution of pile forces assuming (infinitely) rigid behavior are
approximate. The previous method followed well-established and
logical engineering principles to give a reasonable and realistic
distribution for the majority of pile layouts, but had acknowledged
limitations, particularly for unsymmetrical pile layouts. The new method
addresses the limitations for such layouts and will give different/
improved results when these circumstances apply.

Design - Head Code US
• [TSD-8360] - Seismic Design - Steel - it is now possible to use structural

hollow section columns in an ordinary moment frame (OMF) SFRS, in line
with the requirements of AISC 341. Note the following:

• This applies to rectangular, square and circular hollow sections.

• Use of hollow section columns is still beyond scope for IMFs and SMFs.

• Seismic classification is not applicable and Flexural torsion under axial
compression is not checked.

Design - Head Code Eurocode
• [TSD-8802 & 8869] - Steel Design - Partial Safety Factors - making steel

design more flexible, it is now possible to set your own user defined partial
safety factor ℽ values. As shown in the picture below, this is enabled by the
new setting Design > Steel > General > “Use user defined partial safety
factors''. The settings are also found in Global Settings > Design for the
Eurocode country Settings Sets where they can be set for all new models.
When enabled, you can enter your own partial safety factor ℽ values to be
used in steel design. This enhancement applies to all Eurocode Countries
and NA’s.

• As part of this change, the Design settings for Composite Beams and
Steel Joists have been grouped, together with the new Steel > General
settings discussed above, in a new main “Steel” settings group. This
change applies to all Head Codes.
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Reports
• [TSD-5371] - View Items - an issue is fixed in this release with the display in

reports of consecutive view items with applied saved Wind View
Configurations which caused the item to not display with an error "The
image could not be generated!".

NOTE The number in brackets before an item denotes an internal reference
number. This can be quoted to your local Support Department should further
information on an item be required.

1.20 Release notes: Tekla Structural Designer 2021 SP1
This release will upgrade your Tekla Structural Designer installation to version
number 21.1.0.33 and should be installed to ensure optimum function of the
program. It includes a number of enhancements and issue resolutions as
detailed below.

If you are upgrading from a version earlier than the immediately prior release
2021 (version 21.0.0.116 released March 2021), you can find details of
requirements, enhancements and fixes for all previous releases in Tekla User
Assistance (TUA) and Tekla Downloads via the links below:

• Tekla User Assistance Main version release notes

• Tekla User Assistance Service Pack release notes

• Tekla Downloads
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Licensing & Installation
Licensing:

• No new license is required for this version.

• Client License Service Version - the Tekla Structural License Service
V3.3.1.0 update should be installed with this release on clients*. This
update of the license service is released to coincide with the release of
Tekla Structural Designer 2021 SP1 because if this is installed but the
License Service V3.3.1.0 update is not installed, then you may experience a
blank sign-in window when attempting to sign-in to your Trimble Identity
account from Tekla Structural Designer.

• *This update does NOT need to be installed on Sentinel RMS license
servers.

• License Server Version - for Sentinel RMS Server licensing, the latest
version of the Tekla Structural License Service (v3.3.0) (incorporating
Sentinel RMS 9.7) must be installed on your license server to be
compatible with this release. Licensing will not function correctly if this is
not the case. For more on this requirement please see the TUA article Tekla
Analysis & Design 2021 Releases & Sentinel RMS Server Licensing - the
License Server must be updated.

Installation:

• This service pack requires Tekla Structural Designer 2021 first release
(version 21.0.0.116) to be installed and will update your current version.

• Integration:

• Tekla Structures - if you wish to integrate with Tekla Structures you
should install both this release and Tekla Structures 2021 for optimum
performance.

• Note that there have been significant improvements to integration -
especially for rebar - in the 2021 release of Tekla Structures. For
more information about this please see the Tekla Structures Help
Topic Tekla Structural Designer Import and Export.

• Tekla Tedds - to use Design using Tekla Tedds, for optimum
performance you should install Tekla Tedds 2021. This can be obtained
from Tekla Downloads.

• Tekla Portal Frame and Connection Designer 21 - if you wish to
integrate this release with Tekla Portal Frame Designer/ Tekla
Connection Designer - or use these products on their own - you should
install Service Pack 1 for Tekla Portal Frame Designer 21/ Tekla
Connection Designer 21. For more information about this release see
their Release notes. The installation for this can be obtained from Tekla
Downloads.
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• Autodesk Revit© - the Tekla Structural Designer Integrator for
Autodesk Revit© 2021 (version 7.0) was released on 1st July 2020 and
updated to version 7.01 in September 2020. The installation and update
are available in Tekla Downloads. If you are using Autodesk Revit© 2021,
you can install this to perform BIM integration with Tekla Structural
Designer.

• All fixes and enhancements included in the 2021 release and update
were also included in updates for the Integrators specific to the
other currently supported Revit© versions (2018, 2019, 2020). For
more information see the Tekla Structural Designer Integrator
September 2020 updates. If you are performing BIM integration with
any of these Revit© versions, we recommend you update to the
latest version of the associated Integrator.

• Previous Versions and file compatibility - files from all previous versions
can be opened in this release, however note that, once saved, they cannot
then be opened in a previous release. If you wish to retain this option we
therefore recommend using the File > Save As… option to save a copy of
the file in the previous release and retain the original.

Highlights
• Imposed/ Live Load Reductions - Review View Enhancements - All Head

Codes (page 113)

• Steel Beam Design - Enhanced Camber Settings & New Review View
Attribute (page 120)

• Steel Column Base Plate Design - Enhanced Scope for USA Head Code
(page 128)

• New Overall Wind Drift Check - All Head Codes (page 132)

General & Modeling
• A number of additional fixes which are not detailed explicitly here are also

made to improve general performance and stability.

• Embodied Carbon: - a number of further enhancements are made to the
Embodied Carbon calculation features as detailed below.

• New Embodied Carbon eLearning course - to learn more about this
novel and powerful feature we highly recommend you view the new
eLearning for it here; Embodied carbon assessment in Tekla Structural
Designer (eLearning).

• [TSD-9226 and 9227] - Review View - the legend colors for the Embodied
Carbon Review View > Show/Alter state > “Utilization and embodied
carbon” attribute have been adjusted and enhanced to more clearly
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display the distribution of embodied carbon in the model. As shown in
the picture below, the colors now graduate from red (highest embodied
carbon) to green (lowest), and include more gradations.

• In addition, the information text at top left of the Review View
window now includes the Overall Embodied Carbon value (for both
Carbon Factors and Utilization and embodied carbon options), the
number of selected entities in the current view, their amount of
Embodied carbon and the % of the total.
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• Note the following:

• The legend colors are controlled by new settings in Home >
Settings > Scene > Colors > “Gradient Legend” as shown in the
picture below.

• When the displayed content requires fewer values the red and
green extremes remain.
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• [TSD-9213] - Embodied Carbon Factors Dialog - the count of entities to
which a particular carbon factor is assigned given in the Embodied Carbon
factors dialog is corrected to be consistent with that given in the Review
View Legend for the Carbon Factors attribute, as shown in the picture
below. Previously, the value in the Embodied Carbon factors dialog also
counted the steel member connection allowance and so was commonly
considerably larger.
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• [TSD-4951] - User Defined Attributes (UDA’s) - UDA’s have multiple uses -
see for example the Help Topic . In this release, UDA’s assigned to
members can be automatically copied to duplicate floors, facilitating their
application especially in larger models.

• This feature is enabled via a new checkbox for each UDA titled “Linked”
in the User Defined Attributes Settings (both Global and Model) as
shown in the picture below (default setting is disabled). Simply check it
on to enable the automatic copying to duplicate levels of specific UDA’s.

Tekla Structural Designer 2021 release notes 100 Release notes: Tekla Structural Designer 2021 SP1



• Grid Lines:

• [TSD-9328] - Grid Lines in 3D Views - Architectural grids have been
made visible in all 3D Review Views, and are now excluded from
selection and ghosting by default, which helps navigate the model when
using the Review views. Please note the following:

• This change means that if you wish to select and/ or edit the grid
lines using the 3D structure view, you must now enable Scene
Content > “Grid & Construction Lines” and “Show grids in 3D view”
for a Level in the Structure Tree to make the grid lines selectable.

• The functionality in 2D views is unchanged.

• [TSD-4926] - Renumbering - the automated renumbering of Gridlines
has been enhanced with additional controls. To use Renumber, select
‘Renumber’ from the right-click context menu for the “Architectural
Grid” group of the Structure tree. At this point a new configuration
dialog “Renumber Grid” opens, allowing you to specify how the
renumbering will work. This has options of:

• Detect Name type from direction (default ON) - when enabled there
are two naming options for Vertical and Horizontal direction lines.
When off there is only one

• Direction - allows you to select the direction you want the
renumbering to work in.

• Line name type - Alphanumeric or Numeric - and Start value
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• [TSD-4944] - Grid Line Creation - when adding grid lines, two new options
“Next Vertical Grid Name” and “Next Horizontal Grid Name” have been
added to the Properties in the ‘Grid Line Naming’ group. These allow you to
specify grid line name and type prior to its creation.

• Member Properties:

• [TSD-9129] - Columns & Walls - the options ‘Assume extra floors
supported’ and ‘Count floor as being supported’ present in the property
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grid and/or member properties dialog box of column/wall are no longer
listed for the USA and Australia Head Codes as they are not relevant to
these. These options do not play any role in the calculations of Live/
imposed load reduction where this is based on the tributary area
method.

• [TSD-8326] - Braces - in previous releases it was possible to enter invalid
values for the properties Tension > Net area > Percentage value and
Tension > Net area > Effective net area. This is now prevented in this
release - a validation message giving the acceptable range of input is
now displayed when an invalid value is entered.

• Existing files - when opened in this release these values are checked
and when invalid input exists a Validation Error is issued in the
Status tree listing affected braces.

Interoperability
• [TSD-9235] - BIM Integration - Embodied Carbon - the Embodied carbon

results can now be exported to external BIM applications as follows:

• Tekla Structures or Revit - the Embodied carbon results are now
automatically included in the Structural BIM Export CXL file which is
produced by the Tekla Structures/ Revit Export options on the BIM
Integration tab of the ribbon - they can then be displayed in Tekla
Structures/ Revit as attributes as illustrated below.
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• IFC - the values are also included in the IFC export.

• Trimble Connect - uploading an IFC of the model to Trimble Connect will
allow these values to be seen in the Properties when viewing the IFC
model in Trimble Connect as illustrated below.
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• In all cases, the values are exported for members, walls, slabs and
foundations. One value per object is exported - the total resulting
embodied carbon of all constituent materials of the object.

• [TSD-9219] - Grasshopper Live Link - Embodied Carbon - Embodied Carbon
results and Rebar Mass per Volume can now be returned to Grasshopper
using the Concrete Material Quantities and Steel Material Quantities
components. These components operate with filters as previously, and
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new output parameters give the total Embodied Carbon Mass of objects
included in the filter, or the overall Rebar Mass per Volume.

• As well as reporting these values, this allows the user to optimize the
Structural Designer model for these parameters using the optimization
tools in Grasshopper.

For more about the Grasshopper Link see the TUA article Grasshopper - Tekla
Structural Designer Live Link (GH-TSD). The link can be downloaded from the
Tekla Warehouse here.

Loading
Highlights

• Imposed/ Live Load Reductions - Review View Enhancements - All Head
Codes (page 113)

Other Loading Enhancements and Fixes

• [TSD-9144] - Equivalent Horizontal Forces (EHF) - Eurocode - it is now
possible to override the calculated value of ɸ in the Model Settings > EHF
dialog by selecting the new “Override” option as shown in the picture
below. This enhancement is applicable to the Eurocode Head Code (all
countries and NAs).

• When the option is enabled you can enter you own values for ɸx and/ or
ɸy and these are used in place of calculated values in the calculation of
EHFs

• In addition, In Model Settings the formerly titled “EHF” heading has
been renamed to “EHF (Global Imperfections)” for clarity.

Tekla Structural Designer 2021 release notes 106 Release notes: Tekla Structural Designer 2021 SP1

https://teklastructuraldesigner.support.tekla.com/support-article/3028689
https://teklastructuraldesigner.support.tekla.com/support-article/3028689
https://warehouse.tekla.com/#!/catalog/details/0f945de5-ed37-4727-a53c-8a390c5aae67


• [TSD-9284] - Notional Loads/ Horizontal Forces (NL/ NHF) - for Head Codes
other than the Eurocode, a new “NL/NHF(Global Imperfections)'' Setting is
now included in Model Settings, as shown in the picture below (illustrates
this for the USA Head Code). This includes override options for NL/ NHF
parameters for each building direction - typically the proportion of gravity
loads used to calculate the NL/ NHF’s.

• [TSD-6477] - Diaphragm Loads - Creation - application of Diaphragm loads
is now enabled in a 3D View. To facilitate this and their general application,
the following new option and enhancements are added:

• When in a 3D View, a new option “Select Diaphragm Level” is listed in
the Properties window. Load application then operates as follows:

• When enabled - application points will be displayed in all the
diaphragm levels as you move the cursor over available points in the
model. You then specify the load location in two steps: 1) first click
an application point at any level - this ‘locks’ the application point
and displays the available points at each diaphragm level intersected
by a vertical line at the point - then 2) click the point on the level you
wish the load to be applied - it is then created.

• When disabled - the load is applied with a single click on the desired
application point.

• When clicking on a point that is not in a diaphragm level - for
example a point along a grid line in the base level - the load is
created at a position projected vertically to the nearest
diaphragm level.

• Snapping to members, grid and construction lines:

• The application point can now also snap to points along a member
when you move the cursor over one, in a similar manner to the
application of member loads. Just as with applying member loads,
the available snap points are; end, mid, 1/3 and 1/4 points. You can
also apply the load at any point along the member - either by simply
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clicking as you move the cursor along it, or press F2 on your
keyboard to enter the exact distance along the member. This
behavior applies to both 3D and 2D views.

• The application point can also snap to points along grid and
construction lines in just the same manner as for members - again in
both 3D and 2D views.

• [TSD-9160] - Model Settings - Live Load Reductions - USA Head Code - an
issue is fixed in this release in which edits to the Live Load Reduction %
limit values in Model Settings > Live Load Reductions were potentially not
stored correctly when the model was saved. This specifically affected the
following % limit values; "Roof live Beams", "Live walls supporting 1 floor",
"Roof live Columns" and "Live walls supporting 2 or more floors" limits.

• For existing models it is recommended that these limit values are
reviewed and corrected if necessary then, when saved in this release,
they will be stored correctly.

• [TSD-9239] - Ancillaries & Equipment - Operating & Testing Content Load
Case type - for both Pipework Ancillaries (Line & Area) & Equipment load
entities, the loadcase Type (either Dead or Live/ Imposed) for the
automatically created Operating & Testing Content Load cases is specified
in Model Settings > General (default Dead). This setting dictates the
combination factor assigned to these loadcases so, if it is changed, existing
combinations must be updated. To cater for this circumstance, a warning is
added in this release to this effect when such a change is made as shown
in the picture below.
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Design
Highlights

• Imposed/ Live Load Reductions - Review View Enhancements - All Head
Codes (page 113)

• Steel Beam Design - Enhanced Camber Settings & New Review View
Attribute (page 120)

• Steel Column Base Plate Design - Enhanced Scope for USA Head Code
(page 128)

• New Overall Wind Drift Check - All Head Codes (page 132)

General Design Enhancements and Fixes

• [TSD-9039] - Steel Column Base Plates - Review Data - a Design Summary
table has been added for Steel Column Base Plates. To view this summary,
activate the Review View > Tabular Data Window, select the “Design
Summary” option then enable the new “Base Plates'' Characteristic button
as shown in the picture below. This enhancement applies to both the USA
and Eurocode Head Codes. In common with other design summaries you
can do all of the following:

• Export the Table directly to Excel via the Excel Export button,

• Click the “Results...” button at the end of a row to open the design
details dialog.

• Double-click a row to locate that particular base plate in the 3D
Structure view.

Tekla Structural Designer 2021 release notes 109 Release notes: Tekla Structural Designer 2021 SP1



• [TSD-8591] - Seismic Story Drift - it is now possible to override the
previously hardcoded Allowable Story Drift Factor for the Seismic Drift
check. New settings for this are added to the Seismic Wizard on the
Localization page, as illustrated in the pictures below for the USA and
Eurocode Head Codes. This enhancement applies to all Head Codes which
feature Seismic Analysis.

• To enter your own override value, select the Structure Type option,
enable the override checkbox then enter your desired factor value - this
will then be used to calculate the allowable story drift. As shown below,
the Structure type options where listed depend on the model Head
Code.
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• [TSD-8799] - Steel Design - Auto-design Constraints - it is now possible to
set the Size constraints “Min depth” and “Min width” as low as zero.
Previously the lowest limit allowed was 50mm / 2inch which could cause
problems with assigning acceptable sections during design in some
circumstances.

• The default Min depth and Min width values remain unchanged.

Eurocode Design Enhancements and Fixes

• [TSD-8542] - Steel Beam Design - Web Openings - for two circumstances
when closely spaced web openings are such that the Web Posts check is
beyond scope, the following explanatory messages are now issued where
previously there was none (other than the Beyond Scope status):

• Circular openings too closely spaced - “Closely spaced circular openings
- spacing, s_{o} is less than 0.4 \times sum of the radii”
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• Adjacent circular and rectangular openings too closely spaced - “Closely
spaced openings - One opening is rectangular, one is circular and the
spacing, s_{o} is less than 0.5 \times (rectangular opening depth +
circular opening diameter)”

Reports and Drawings
• Report Styles

• [TSD-7879] - Ancillary and Equipment Loads - a new report style
‘Industrial Structure Loading’ has been added to report the details of
the following loading elements (which are typically - though not
exclusively - used for Industrial structures); Line Ancillaries, Area
Ancillaries & Equipment.

• The new report consists of tables for each of these load entities,
listing their principal properties and values; Name, Type, Location,
Area, Loadcase Title and Applied load.

• Note that existing models will not include the new default style,
however you can easily create it as shown in the picture below by 1)
Adding a new style (naming it as you like) then 2) dragging the new
“Industrial Structure Loading” Chapter into this.
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• [TSD-4951] - the default "Building Analysis checks" report style is
renamed to"Building Analysis & Drift Checks". In addition the "Wind
drift" option is added to this style, together with the "Loadcase
summary" and "Sway / Drift" options as appropriate to the Head Code.

• Note that existing models will not include these amendments,
however you can easily adjust the existing "Building Analysis checks"
style to make these same changes should you wish to.

Notes
The number in brackets before an item denotes an internal reference number.
This can be quoted to your local Support Department should further
information on an item be required.

Imposed/ Live Load Reductions - Review View
Enhancements - All Head Codes
While Tekla Structural Designer has always featured a sophisticated
automated approach to the calculation of Imposed/ Live Load Reductions (as
described in the Help Topic ), the process of applying these reductions is quite
simple (as described in this Help topic ) and fully within the engineer’s control.

The engineer may like to review automatically applied reductions and there
are some situations where automatic reduction is not possible and/ or
engineering judgment may be required, hence some manual review/
adjustment is necessary. To facilitate this, the Review View > Show Alter state
is now enhanced with a new dedicated attribute for Imposed/ Live Load
Reductions (I/LLR), enabling rapid and efficient graphical review and control of
reduction settings and values.

An example is illustrated in the picture below (Eurocode) showing the new
Review mode for the Imposed/ Live Load Reductions Show/Alter state
Attribute.
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• In the above example, the following manual ILR adjustments are made:

• Transfer beams in the fourth floor - logically these would have at least
the same reduction as the columns they support, which themselves
support four floors - hence at least 30%. A manual 30% reduction is
applied

• Discontinuous transfer columns - these also support four floors above
so logically would have the same reduction as the continuous columns
to either side supporting the same number of floors directly. A manual
4 extra floors supported is applied (entire member), producing an
automatic 40% reduction for the full height.
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• Transfer Slab in the first floor lower section of the building - logically
this would have at least the same reduction as the column it supports,
which itself supports three floors - so at least 20%. A manual 20%
reduction is applied

• Mat slabs - following a similar rationale, the panel under the taller
section of the building is set to 40% reduction (matching the columns/
walls it supports) and under the lower section to 30% reduction.

The operation and settings available for Imposed/ Live Load Reductions
depend on the model Design Code, which dictates the fundamental method of
calculating reductions; by a tributary area approach (USA & Australian Head
Codes) or by the number of supported floors (other Head Codes).

Some key aspects/ differences specific to Head Codes are noted briefly below:

• In common with other attributes, there are two principal modes for the
new I/LLR attribute; Review and Set:

• Review Mode - this allows review of the following I/LLR attributes via
automated color coding and legend:

• Applied live load reduction factor (applicable to all Head Codes)

• Reduce Imposed/ Live load by (applicable to all Head Codes) - the
reduction factor expressed as a % reduced by e.g. reduction factor of
0.6 = reduced by 40%.

• Count the floor as supported (applicable to all Head Codes except USA
and Australia)

• Number of floors carried (applicable to all Head Codes except USA and
Australia)

• KLL value (applicable to USA Head Code only)

• Using the Review mode for example for the USA Head Code, you can easily
review all the automatically calculated reduction factors (from tributary
areas) as well as the assigned default KLL factors as illustrated in the
pictures below. The tooltip of a selected entity also includes the principal
I/LLR data.
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• Set Mode - allows you to graphically edit the I/LLR settings as follows:

• Reduce imposed loads by - using this you can manually apply specified
reduction % values using mouse operations as illustrated in the picture
below. As this shows, you can use two adjacent 3D Structure views - one
in Review mode and one in Set mode - to simultaneously view the
applied reductions as a guide in one while manually making
adjustments in the other.

• With the “Entire member” option enabled, the value is applied to the
entirety of continuous entities such as beams, columns and walls.
When off it can be applied to individual spans/ stacks/ panels. You
can also enable an entity type filter to apply the operation only to
beams for example.
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• Assume extra floors supported - using this you can manually apply a
specified number of extra supported floors as illustrated in the picture
below for transfer columns for example. The automatically calculated
reductions are then updated accordingly. This control has the same
additional “Entire member” and entity filter options.
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• Count the floor as being supported - using this you can manually edit
the “Count the floor as being supported” Level property for columns
and walls as illustrated in the pictures below. Note that this property
defaults to on for all stacks/ panels for all levels set to be a floor that a
column/ wall intersects and hence are listed in the column/ wall
properties.

• To change this setting, uncheck the “Count the floor as being
supported” option and also the “Entire member” option to edit
individual level settings, then click on a column stack/ wall panel to
apply. Note the following:

• Only stacks/ panels with their setting opposite that of the current
“Count the floor as being supported” setting in the Attribute
Properties can be selected for editing - the cursor tooltip displays
the current settings at the upper/ lower ends of a selected stack/
panel for selectable entities.
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• Since the setting applies to the ends of stacks/ panels, it works in
a similar manner to editing member end releases using the
Fixed/ Pinned Show/ Alter state command; you can click near the
end of a stack/ panel to apply the setting only to the level for that
end, or in the middle to apply it to the levels at both ends.

• KLL - USA Head Code only - using this you can manually edit the Live
Load reduction factor KLL for entities.
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NOTE The following new Help Topics provide more details of how to use each of the
modes described above:

• - for the USA

• - for other Head Codes

Steel Beam Design - Enhanced Camber Settings & New
Review View Attribute
Previous Tekla Structural Designer releases have featured the option to apply
camber to steel beams - both composite and non-composite - including
automatic camber calculation and application based on a number of criteria.
For more about this see the Composite Beam deflections including camber
TUA article. Following customer feedback, In this release the settings and
processes for camber have been thoroughly reviewed and enhanced to give
increased flexibility and make the workflow more intuitive.

In addition the Review View > Show Alter state is enhanced with a new
dedicated attribute for Camber, enabling rapid and efficient graphical review
and control of its settings and values. Camber values are also now included in
the beam design summary tables and associated report items. These
enhancements apply to all Head Codes that feature steel and steel composite
beam design.
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Camber Settings Enhancements

As in previous releases, camber can either be off, or applied as one of three
options; Value (an absolute dimension), Proportion of span (automatically
calculated and applied as a proportion of the span length) or Proportion of
deflection (automatically calculated and applied as a proportion of deflection
resulting from the applied loads).
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• The principal enhancements and changes to operation are:

• Apply camber: Proportion of deflection - this option is renamed from
“Proportion of dead load deflection” since it also has the option to
include a proportion of Live/ Imposed loads. The following additional
changes are made:

• The previous “Dead load” setting - with options of “Slab only” and “All
dead” - is removed.

• In its place, there are now separate settings for the proportion of
self-weight deflection (which includes the self weight of the slab +
the steel beam section) and Dead deflection (applies to other dead
loadcases, which are assumed to be applied post-composite
action)*.

• *Note that, similar to previous behavior, both these options are
automatically disabled and set = 100% when the proportion of
Imposed deflection is set to be greater than > 0% (this being the
default value). The rationale for this behavior is that all the dead
loads will have already been applied by the time the imposed
loads are.

• These changes improve the clarity and simplicity of defining what
factors affect the camber calculation and how. They also improve
flexibility in enabling different percentages to be set for selfweight
and applied dead load

• Maximum allowable camber - a new criteria that applies to all of the
camber application options; Value, Proportion of span, Proportion of
deflection. Key aspects of this option are:

• It allows the user to pre-set the maximum amount of camber that is
allowed for the member.

• For a camber value above this limit there will be an explanatory
warning in the beam check results.

• The auto-design process will look for sections in the design list that
fulfill this limit.

• Do not apply if beam length is < - a new criteria that applies to all of
the camber application options; Value, Proportion of span, Proportion
of deflection. Key aspects of this option are:

• Allows the user to define the minimum beam length for camber to
be applied.

• Camber is not applied to beams of length equal or below this limit.

• Do not apply if web thickness < - a new criteria that applies to all
types of the camber application options; Value, Proportion of span,
Proportion of deflection. Key aspects of this option are:

• Allows the user to define the minimum section web thickness that
camber should be applied for.
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• For camber values at or below this limit there will be an explanatory
warning in the beam check results.

• The auto-design process will only consider sections in the design
order list that comply with this limit.

• Do not apply if required camber is < - the operation of this option is
essentially unchanged, however the condition for application of the
limit is amended to less than ( < ) the limiting value rather than less than
or equal to ( <= ) as previously . Thus for example, with the limit set =
20mm, a calculated camber of 20mm would be applied where
previously it was not.

• For existing models the original limit value is therefore automatically
increased accordingly to match the previous behavior as closely as
possible*. The value of the increase is the same as the “to nearest”
value for Head Codes that default to metric units and half this value
for those that default to US-customary units.

• *Despite this adjustment, it is still possible that due to this
change of condition, camber may not be applied in this release in
some cases where it was previously. Thus we recommend that
the camber settings and results are carefully reviewed in this
release - this process should now be much simplified by the
addition of the new review view attribute for camber.

Review View > Show/Alter State - Camber

A new dedicated Review View “Camber” attribute is added to those for Show/
Alter state, enabling quick and easy review and editing of all the camber
settings. As shown in the picture below, this is selected at the top of the
Properties Window when Show/ Alter state is activated on the Review Ribbon
and has the following Modes; Review, Set On, Set Off, Toggle and Copy.
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• Review Mode - this displays a color coded view and associated legend
showing the distribution of the different camber settings; Value, Proportion
of span, Proportion of deflection and Off.

• Set On Mode - with this mode selected you then select the “Apply
as”option from the following; Value, Proportion of span, Proportion of
deflection.

• You can then input your desired settings/ values in the properties
window and apply these graphically to beams in the model using mouse
operations . The color coding and legend indicate which beams have;
the current settings applied, Camber off or Other settings. These will
update automatically following changes to the current properties. For
beams with “Other details”, the cursor tooltip displays all their current
settings when selected by moving the cursor over them, as shown in the
picture below
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• Set Off Mode - turns camber fully off for selected beam(s):

• Members in view are color coded by camber status (On / Off).

• Member tooltip includes the full set of camber properties currently
applied.

• The tooltip of members with camber applied includes the camber
calculation method.
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• Toggle Mode - sets camber on or off for selected beam(s) depending on
their current state:

• Members in view are color coded by camber status (On / Off).

• If the member being turned on has had camber properties previously
defined, these will be persisted, otherwise the defaults are used.

• The tooltip of members with camber applied includes the camber
calculation method.

• Copy Mode - using this you can copy all the camber settings from one
beam to one or multiple other beams.

• To use this you first click the Source beam as indicated in the picture
below - other beams in the view are then automatically color coded to
indicate which are the same as the source and which are valid target
beams to which the source beam properties can be copied. You can
then use mouse operations to select the target beam(s).

Review View > Tabular Data, Reports and Drawings

A new column giving the applied camber value for each beam is also added to
the Tabular data > Design summary table for steel/ composite beams and the
associated report items.
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Although not new for this release, note that the camber value is also
automatically included in drawings as illustrated in the picture below showing
a General Arrangement Drawing - the camber value is included in the Steel
Beam Attributes text in this manner for example “C=1.00”.
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Steel Column Base Plate Design - Enhanced Scope for USA
Head Code
The scope of Steel Column Base Plate Design checks is significantly enhanced
in this release for the USA Head Code, making it applicable to a wider range of
loading conditions. Major axis shear loading is now checked for the shear
resistance of the rods and/ or concrete and the welds are now also checked as
shown in the picture below. In addition, all the applied forces are reviewed
and beyond scope and/ or Ignored forces warnings issued as appropriate for
cases that are not considered by the design. For full details of the checks
performed, please see the updated Help Topic .
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• The enhanced and new checks are as follows for applied Major axis shear
load - both with/ without Positive vertical load.

• Base Plate

• Bearing strength of concrete foundation.

• Base plate thickness.

• Shear

• Friction Strength

• Shear strength of rods

• Concrete anchorage strength for shear forces on rods

• Concrete pry-out strength of anchor rod in shear

• Weld

• Weld shear strength

• Shear Check - the shear capacity calculations performed are dependent on
the Horizontal Shear Transfer option selected in the settings page/ group for
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“Rods” as shown in the picture below left. This has options of; Friction Alone
(default), Shear on Rods Alone and Friction and Shear on Rods. The picture
below right shows an example of the check details for the shear strength of
rods with the Friction and Shear on Rods option selected. Below we give
some brief details of checks performed and their references - for fuller
details please see the updated Help Topic .

• Friction Alone - for this the shear strength check is calculated in
accordance with ACI 318 and considers the full (major) shear force.
Note the following:

• Since ACI 318 only considers LRFD requirements, this check is not
performed for ASD load combinations.

• The default for μ, the coefficient of friction between the base plate
and concrete, is taken as 0.4 per ACI 349-01 (section RB.6.1.4),
349-06 and -13 (section RD.6.1.4).

• Shear on Rods Alone - checks for this option are divided into the
following three separate parts and consider the full (major) shear force:
1) Shear strength of rods 2) Concrete anchorage strength for shear
forces on rods 3) Concrete pry-out strength of anchor rod in shear.
Note the following:

• The anchor rod strength is calculated in accordance with AISC 360
and AISC Design Guide 1 for both LRFD and ASD load combinations.

• For the concrete strength checks - these are calculated in
accordance with ACI 318 and since this only considers LRFD
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requirements these checks are not performed for ASD load
combinations.

• Friction and Shear on Rods - when this option is selected, the three
Shear on Rods checks consider a net shear force i.e. the remaining
(major axis) shear force not taken by frictional resistance alone.

• Checks for Friction and Shear on Rods are divided into the same
three separate parts as for Shear on Rods Alone described above,
with the addition of a Friction calculation at the start of each of the
three Shear on Rods parts that derives the net (major) shear force

• Weld Check - the welds are checked for one design condition: shear.

• Weld Shear Strength

• For base plates with thickness <= 3/4 in (19 mm), the default weld leg
length is 1/4 in (6mm) and for all other base plate thicknesses the
default weld leg length is 5/16 in (8 mm). These defaults can be
adjusted in the database [Home > Materials > Welds > Defaults].

• AISC 360-10 and -16 stipulates that, when the length of the weld
exceeds 300 times the leg size, w, the effective length shall be taken
as 180w (section J.2b.(d).(3)), and this is similarly applied when AISC
360-05 has been selected for steel design.

• Beyond Scope/ Ignored forces - all the forces applied to a base plate
connection are now fully reviewed and compared to those considered by
the design. Where they are beyond scope and/ or ignored, an appropriate
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status is issued in the check details and reflected in the Review View >
Design Status and connection entity tooltip. The picture below is an
example of the check details showing this.

• Beyond Scope - this status is issued for applied negative vertical load
(uplift) or major axis moment. No design checks are performed for
combinations where either or both of these are present.

• Ignored forces - this applies to minor axis moment and shear; where
their value is greater than a given limit*, they are displayed in the check
details together with a Warning status. Where all other forces are within
scope, all the design checks are carried out and the engineer can make
a judgement on their validity.

• *The given limits are defined on the Design Forces page of the
Design Settings dialog available from the Design tab on the ribbon.

New Overall Wind Drift Check - All Head Codes
In line with customer requests, a new Overall Wind Drift check option is added
in this release. This checks the maximum deflection at the top of the structure
relative to its total height against a specified limit. When activated, the check is
fully automated and is carried out/ updated when any of the following
processes are run; Analyze > Analyze All (Static) or 3D Only (Static); any of the
Design Steel/ Concrete/ All (Static) options of the Analysis & Design groups of
the Design Ribbon.

• The check is enabled by a new “Check for Overall Wind Drift” option in the
“Sway & Drift Checks” Design Settings, as shown in the picture below. When
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this is enabled, the desired drift limit value can be entered (default 500). By
default this new setting is enabled for new models but not for existing
models.

• Key aspects of the check undertaken are as follows:

• When the “Check for Resultant Wind Drift” option is enabled, a single
maximum resultant deflection value is checked, otherwise the
deflection values in Dir1 and Dir2 are considered separately and the
maximum of these is checked.

• The height of the structure considered by the check is the distance
between highest and lowest levels with the “Check for drift” level setting
enabled.

• Check Results - The results of the check are reported in the “Design” group
of the Status tree under the heading “Overall Wind Drift” as shown in the
picture below. This reports; the governing deflection value, the
combination it occurs for and the node it occurs at.

• You can double click the message to locate and highlight the node in
the Solver View.

• You can also right click over the message and select the “Details” option
from the resulting context menu to see full details of the check, as
shown below.
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